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Complete Reference on Ms Word Equation
Editor Shortcut
Ms word

Equation is an integral part of many technical manuscripts, including thesis and research papers.

However, typing it in Ms Word is cumbersome and tiring task. To ease it, Microsoft Word has
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LaTeX type equation editor shortcut feature for typing equation. These equation editor shortcut

as termed as Math AutoCorrect and are available in versions of Microsoft Word 2007 and above.

Equation editor shortcut has a potential to save a lot of time and effort. For e.g., to get Greek

letter , you can type \alpha instead of going to Symbols in Insert Tab and searching for .

Enabling Math Autocorrect
Most version of Microsoft Word, Math AutoCorrect is enabled by default. To ensure you can visit,

File Menu → Options → Proofing → Autocorrect Options → Math AutoCorrect and ensure box

against “Replace text as you type” is checked. These shortcut work only inside Equation Editor.

However, if you want to use it outside Equation Editor, then check “Use Math Autocorrect Rules

outside of math regions“

How to enable math autocorrect outside math region in Microsoft Word

Equation Editor Shortcut
Shortcut to get equation editor in Ms Word and Power Point is “Shortcut to get equation editor in Ms Word and Power Point is “Alt + =Alt + =” (i.e. hold down Alt key” (i.e. hold down Alt key

while typing ‘=’). Although you can also click on “Equations” under the “Insert” Tab to get it.while typing ‘=’). Although you can also click on “Equations” under the “Insert” Tab to get it.

Spaces is an important part of Math AutoCorrect shortcut. It tells Ms Word and Power Point

when it is time to translate a part of equation into Mathematical Symbols/Operators. For clarity

whenever necessary, space are shown as <sp> in Math AutoCorrect formula.
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Subscript & Superscript

Equation editor shortcut for subscript and superscript is _ and ^. Anything after _ or ^ will get

converted into subscript or superscript respectively, after hitting space. To include space in

subscript or superscript, group them in () or parenthesis. These grouping parenthesis don’t

appear after Math AutoCorrect. Grouping is also important as it distinguish between  and .

While adding pre-subscript or pre-superscript, use \zwsp along with _ and ^ sign as shown

below.

Latest keyboard shortcut for equation in Word similar to LaTeXLatest keyboard shortcut for equation in Word similar to LaTeX

Smartest way to type equation in equation editor in Word (similar to LaTeX): SupersSmartest way to type equation in equation editor in Word (similar to LaTeX): Supers……
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Use For Use For

A_circle<sp> r^2<sp>

A_(big circle)<sp> H^(2 square)<sp>

r^2_outer<sp> r^2_(outer circle)

\zwsp<sp>_c<sp> \zwsp<sp>^c<sp>R

\zwsp<sp>_c^d<sp>R \zwsp<sp>_c^d<sp>_e^f<sp>

Equation Editor Shortcut for Subscript and Superscript in Ms Word

Letters

Blackboard Bold letters or Double letters:

Use \doubleXX, where XX is the required uppercase letter for e.g. use \doubleA for  and

\doubleR for .

Fraktur letters

Fraktur is a calligraphic hand of the Latin alphabet. We can easily write it in Ms Word using

\frakturXX where XX is an uppercase letter. For e.g. use Ms Word shortcut “\frakturB” for “ “ and

“\frakturG” for “ “.

Greek letter

Greek letter has 24 different alphabets. There are four distinct ways of typing Greek alphabets in

Microsoft Word. Of these, Math AutoCorrect method is the easiest to remember and the fastest

of all four. This method of typing Greek letters is as easy as typing its spelling after \ (backslash).

To get lower case Greek Alphabet, type name of Greek letter after \ in lower case (for e.g.
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\alpha for ) and for upper case Greek Alphabet type name of Greek letter after \ in Title Case

(e.g. \Gamma for ). You can also use Alt codes for typing Greek letters.

Name of Greek letter Uppecase Shortcut Lowercase Shortcut

Alpha A \Alpha \alpha

Beta B \Beta \beta

Gamma \Gamma \gamma

Delta \Delta \delta

Epsilon E \Epsilon \epsilon

Zeta Z \Zeta \zeta

Eta H \Eta \eta

How to use equation editor in Ms Office (similar to LaTeX): Shortcut for typing GreeHow to use equation editor in Ms Office (similar to LaTeX): Shortcut for typing Gree……
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Name of Greek letter Uppecase Shortcut Lowercase Shortcut

Theta \Theta \theta

Iota I \Iota \iota

Kappa K \Kappa \kappa

Lambda \Lambda \lambda

Mu M \Mu \mu

Nu N \Nu \nu

Xi \Xi \xi

Pi \Pi \pi

Rho P \Rho \rho

Sigma \Sigma \sigma

Tau T \Tau \tau

Upsilon \Upsilon \upsilon

Phi \Phi \phi

Chi X \Chi \chi

Psi \Psi \psi

Omega \Omega \omega

Scientific and Mathematical Symbol Symbols

Equation editor shortcut for scientific and mathematical symbols like infinity, different arrows,

operators (like partial, del and nabla), conditional symbols, dot, cross, mapsto, perpendicular, set

symbols, for all, equivalent, congruent, angle, proportional etc are given in the following table.We use cookies to ensure that we give you the best experience on our website. If you continue to use this site we will assume that
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Correct way to insert multiplication and division symbols in Ms Word

Microsoft word shortcut for inserting division sign using Math Autocorrect

Shortcut for typing chemical reaction arrows and text above and below arrows in wShortcut for typing chemical reaction arrows and text above and below arrows in w……
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Show 10  entries Search:

Showing 1 to 10 of 31 entries

Infinity ∞ \infty Hbar ℏ \hbar

Right Arrow → \rightarrow, -> Left Arrow ← \leftarrow

Up Arrow ↑ \uparrow Down Arrow ↓ \downarrow

North-east

Arrow

↗ \nearrow North-west

Arrow

↖ \nwarrow

South-east

Arrow

↘ \searrow South-west

Arrow

↙ \swarrow

Left Right

arrow

↔ \leftrightarrow Up Down Arrow ↕ \updownarrow

Rightwards

Double Arrow

⇒ \Rightarrow Leftwards

Double Arrow

⇐ \Leftarrow

Upwards

Double Arrow

⇑ \Uparrow Downwards

Double Arrow

⇓ \Downarrow

Partial ∂ \partial Nabla ∇ \nabla

Less Than

Equal To

≤ \le Greater Than

Equal To

≥ \ge

Accent

For various reasons you need to have an accent like bar, grave, tilde, dot (for denoting derivative)

above symbol. We can easily achieve these using following word shortcut.

Symbol

Name
 Symbol 

Ms Word

Shortcut
 Symbol Name  Symbol 

Ms Word

Shortcut


Previous Next 

Shortcut for typing vector, arrow, hat, cap, bar, dot, double dot & other accent over leShortcut for typing vector, arrow, hat, cap, bar, dot, double dot & other accent over le……We use cookies to ensure that we give you the best experience on our website. If you continue to use this site we will assume that
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Accent For Equation editor shortcut

Bar x\bar<sp>

Double bar x\Bar<sp>

Under bar x\ubar<sp>

Double under bar x\uBar<sp>

Acute x\acute<sp>

Grave x\grave<sp>

Vector x\vec<sp>

Hat x\hat<sp>

Left-right arrow x\tvec<sp>

Left harpoon x\lhvec<sp>

Right harpoon x\rhvec<sp>

Dot x\dot<sp>

Double dot x\ddot<sp>

Triple dot x\dddot<sp>
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Accent For Equation editor shortcut

Four dot x\ddddot<sp>

Breve x\breve<sp>

Check x\check<sp>

Tilde x\tilde<sp>

Left vector (or left arrow) x\lvec<sp>

Ms Word shortcut for Accents

Grouping and brackets

Equation editor causes brackets (such as [], {} and ()) to grow to fit the size of expression within

them. However, parenthesis used for grouping are not displayed in the final formatted

expression. However, when parenthesis is required to be displayed, it must be doubled (one for

grouping which will vanish in final formatted expression and other for displaying). Escape

sequence (\ followed by desired bracket is used to prevent bracket from being reformatted.

To

Display
Use Comment

x/y / is used for fraction

[x/y] [] bracket automatically expands to adjust fraction

{x/y}

(x/y) Parentheses displayed as they not used for grouping

a/(p+q)
Parentheses used for grouping (denominator here) are not

displayed

a/((p+q))
Parentheses used for grouping (denominator here) is not

displayedWe use cookies to ensure that we give you the best experience on our website. If you continue to use this site we will assume that
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To

Display
Use Comment

[ a\atop b \close

y

|(p|q|r)/(c+d)| Again parentheses used for grouping are not displayed

|a|b|x/(a+b) Grouping parentheses not displayed

\norm a \norm

Brackets and grouping equation

Square root, Cube root, and more

Equation editor shortcut for square root, cube root and higher roots are \sqrt(), \cbrt() and

\sqrt(n&x) respectively.

Symbol Equation Editor Shortcut

\sqrt(x)<sp>

\cbrt(x+1)<sp>

\sqrt(n&x)<sp>

Equation Editor Shortcut for square root, cube root & nth root

For more shortcut and example on root sign, visit our blog on Shortcut for Square root, and

higher order roots

Matrices

Empty Matrix

The basic equation editor shortcut for creating an empty matrix of custom size is

\matrix(@@&&&)<sp>. Matrix size decided by number of @ (for rows) and & (for columns)

respectively. Number of @ and & symbol is one less than number of rows and columns,

respectively.
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Animation of fastest way to insert matrix in Ms Word using equation editor shortcut.

Speed comparison of Two methods to insert 4×4 or larger matrix in Microsoft Word

Matrix with elements

You can also create matrix filled with elements using above shortcut. Using this method, we

enter elements of the matrix row wise, starting with the top row. Use & to move to the next

column and @ for the next row.
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Show 10  entries Search:

\matrix(@@&)

\pmatrix(@@&) or (\matrix(@@&)

\Vmatrix(@@&)

[\matrix(1&2&3@4&5&6@7&8&9)]

Equation Editor Shortcut  Output Matrix 
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Showing 1 to 5 of 5 entries

Show 10  entries Search:

\pmatrix(1&2@3&4@5&6)

For more details and example, visit our blog on different methods and equation editor shortcut

for typing matrix in Ms Word.

Piece wise function

There are two ways to insert piece wise function in using Equation Editor shortcut in Ms Word.

First one uses \cases() method while the second one uses \matrix(). In both the cases, desired

piecewise functions are entered inside the parenthesis.

Like matrix, @ is used as a row separator. To get only the opening curly braces ‘{‘ which

automatically extends the height of piecewise function, use \close in place of closing ‘}’.

f(x) =

{\cases(x,x>=0@-

x,x<0)\close

@ is used as row separator and

\close is required to ensure

opening { expands vertically to

cover all cases

f(x) = {\matrix(x &

x>=0@-x &

x<0)\close

Similar to above, & is used as

column separator

Equation Editor Shortcut  Output Matrix 

Previous Next 

Equation editor

shortcut
 Output  Note 
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Showing 1 to 3 of 3 entries

f(x) = {\matrix(x &

x>=0@-x & x<0)

Piecewise function without \close

Without \close, opening '{'

doesn't expands

Integral, Sum and Product

Shortcut for integral sign, sum and product signs are \int, \sum and \prod. You can use _ and ^

for inserting text below and above signs, respectively.

Equation Editor Shortcut Output Note

\int<sp>f(x)dx

\int_x=0^1<sp>f(x)dx _ for lower limit and ^ for upper limit

\iint<sp>f(x)dx \iint for double integral

\iint\below(S)<sp>ds use \below to put text below symbol

\iiint\above(V)<sp><sp>dV use \above to put text above symbol

\oint<sp>f(x)dx
\oint for cyclic integral, similarly use \oiint for cyclic

double Sum, integral

\sum_(i=1)^n<sp>A_i<sp>

\sum_(i=1)^n<sp>A_i<sp>\sum for sum symbol and _ &

^ sign for getting text below and above sum.

Parenthesis can be used for grouping text with spaces

\prod_(n=0)^N<sp>x^n<sp> Similar to sum.

Ms Word shortcut for typing Integration, Sum and Product

Conclusion

Equation editor

shortcut
 Output  Note 

Previous Next 
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 Pandas Head() & Tail() Functions Commonly Used Functions in Pandas 

Math Autocorrect shortcut provides useful shortcuts for typing most of the mathematical

expression. They are often the fastest and efficient way of typing equation in Ms Word.

13 thoughts on “Complete Reference on Ms Word Equation Editor
Shortcut”

 spiritual benefits of bitter kola says:

October 2, 2020 at 12:42 pm

I cannot thank you enough for the article. Much thanks again. Cool!.

Reply

 Edirisooriya says:

November 26, 2020 at 10:15 am

Thank you is not enough for the knowledge you have shared. Keep on doing your good

work.

Thank you very much indeed.

Reply

 Elias says:

February 16, 2021 at 11:15 pm

Thank you so much. This is super helpful to me.
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 ES says:

March 26, 2021 at 6:27 pm

Just brilliant. Thank you so much and may your tribe increase.

Reply

 pickupbr says:

March 26, 2021 at 10:34 pm

Glad you liked it.

Reply

 Seth Odoom says:

July 8, 2021 at 1:12 pm

Very helpful. This is what I have been struggling with all this time. Thank you.

Reply

 pickupbr says:

July 10, 2021 at 7:25 pm

Thanks very much dear for the comment. Glad you liked it.

Reply

 Franco says:

July 19, 2021 at 8:47 pm

Thank you very much, I’m at Word 2016 and my accent shortcuts doesn’t work, if I write

x\bar it’ll do x ̅ instead of ̅x ̅
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Reply

 pickupbr says:

July 21, 2021 at 12:25 pm

You should press space twice. First space is to convert \bar to bar sign and other to

put under x. Thanks for highlighting this mistake I will update it.

Reply

 Jennifer Seymour says:

October 20, 2021 at 11:57 pm

Hello, is there a way to do an arc symbol? Like “breve” but with the accent flipped?

Reply

Pingback: Inclusive Math Part2, Mathematics using the LaTeX autocorrect editor! - Inclusion

The Motto!

 Adekunle Olumayowa says:

December 1, 2021 at 1:09 pm

Wow!!! I can’t believe typing mathematical equations can be made easy like this. This is first

hand help for everyone that has been depending on mouse for insertion of symbols,

equations and its structures. Lots of thank you to the author or writer of this blog.

Reply

 pickupbr says:

December 6, 2021 at 7:12 pm
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Thanks dear for the feedback. Yes, this feature is really awesome and saves lots of

time while inserting equations.

Reply

Leave a Reply

Enter your comment here...Enter your comment here...
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